
IBM Infoprint Manager for Windows Readme

This readme contains the following information:
v “General Release Notes for Infoprint Manager for Windows”: contains topics

that apply to Infoprint Manager for Windows in general. When this information
changes, it will be marked with revision bars ( | ) in the left margin.

v “Release Notes for Version 1.1.0 PTF UR53724 (June 2003)” on page 5 contains
release notes that apply to PTF UR47615 (July 2002)

v “Release Notes for Version 1.1.0 PTF UR53463 (July 2002)” on page 6 contains
release notes that apply to PTF UR53724 (June 2003)

v “Release Notes for Version 1.1.0 PTF UR52773 (January 2002)” on page 6 contains
release notes that apply to PTF UR52773 (January 2002)

v “Release Notes for Version 1.1.0 PTF UR52622 (October 2001)” on page 6:
contains release notes that apply to PTF UR52622 (October 2001).

v “Release Notes for Version 1.1.0 PTF UR52621 (June 2001)” on page 11: contains
release notes that apply to PTF UR52621 (June 2001).

v “Release Notes for Version 1.1.0 PTF UR52772 (May 2001)” on page 12: contains
release notes that apply to PTF UR52772 (May 2001).

v “Release Notes for Version 1.1.0 PTF UR52620 (March 2001)” on page 12:
contains release notes that apply to PTF UR52620 (March 2001).

v “Release Notes for Version 1.1.0 PTF UR52402 (December 2000)” on page 14:
contains release notes that apply to PTF UR52402 (December 2000).

v “Release Notes for Version 1.1.0 PTF UR52401 (October 2000)” on page 15:
contains release notes that apply to PTF UR52401 (October 2000).

v “Release Notes for Version 1.1.0 PTF UR52375 (August 2000)” on page 18:
contains release notes that apply to PTF UR52375 (August 2000).

v “Release Notes for Version 1.1.0 PTF U469452 (June 2000)” on page 20: contains
release notes that apply to PTF U469452 (June 2000).

v “Release Notes for Version 1.1.0” on page 20: contains release notes that apply to
the Version 1 Release 1 code.

Note: The release notes for the most recent PTF will always follow the General
Release Notes.

General Release Notes for Infoprint Manager for Windows

Server Software Prerequisites
The primary software prerequisite for the IBM Infoprint Manager for Windows
server software is one of the following Microsoft® operating systems:
v Windows NT Workstation 4.0 (Service Pack 6a or later)
v Windows NT Server 4.0 (Service Pack 6a or later)
v Windows 2000 Professional
v Windows 2000 Server
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Notes:

1. Windows NT Workstation and Windows 2000 Professional operating systems
have strict limitations on the number of connections. Ensure that an adequate
version of Windows is used on your Infoprint Manager Server to meet your
connection requirements.

2. Service Pack 4 or 5 work with Infoprint Manager for Windows NT, but IBM
recommends using Service Pack 6a for printing support.

Before Installing Any PTF, Backup Install Directories
Before you install any PTF, it is strongly recommended that you back up your IBM
Infoprint Manager for Windows install directories, any directories that have been
moved out from under the install directory since the initial installation of the
product, and the Windows registry. Directories that have been moved out from
under the install directory can be identified through the Infoprint Manager
Management Console (Start–→Programs–→IBM Infoprint Manager–→Management
Console). From the Management Console, go to Edit–→Service Configuration....
Check all paths listed on the displayed panel to determine if any are not in the
base install directory. Make note of any paths that are not in the base install
directory.

This backup will be required in the event that you wish to remove the PTF from
your system and restore Infoprint Manager to its previous state.

Note: You may want to test the PTF on a non-production system before installing
it in a production environment.

To backup your system, complete the following steps:
1. Stop job submissions to the Infoprint Manager Server.
2. Complete printing of all jobs possible.
3. Close the Infoprint Manager Administration and Operations GUIs if they are

open.
4. Shutdown the Infoprint Manager Server. Using the Infoprint Manager

Management Console, go to File–→Stop Server.
5. Clean up segment files. Using the Infoprint Manager Management Console, go

to Debug–→Clean Up Leftover Manager Files and close the Management
Console.

6. Use your local backup procedures to backup the install directories, any
directories that have been moved out from under the install directories, and the
Windows registry. The following key and sub-keys must be restorable:
HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Infoprint Manager.

Note: In a multi-server environment, all servers must be backed up at the same
time.

Close Infoprint Manager Administration GUI and Infoprint
Manager Operations GUI before installing any Infoprint
Manager PTF

Be sure to close the Infoprint Manager Administration GUI and the Infoprint
Manager Operations GUI before installing any Infoprint Manager PTF to avoid
problems with files that need to be replaced.
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Ensure that the Infoprint Manager Server and the Infoprint
Manager Administration and Operations GUIs are at the same
level

To access all changes as they are released in PTFs, ensure that the Infoprint
Manager Server is at the same level or at a higher level of service than the
Infoprint Manager Administration GUI and the Infoprint Manager Operations GUI.
Otherwise, you may receive error messages like: 5010-625 Cannot recognize
attribute....

Note: For this to occur, the Infoprint Manager Administration GUI or the Infoprint
Manager Operations GUI would have to be running on a different
workstation than the Infoprint Manager Server. This might occur if you
install a new version of a GUI on a workstation and point to a downlevel
Infoprint Manager Server.

PSF Direct and SecureWay Communications Server
If you use PSF Direct to print from host systems, you must also install IBM
SecureWay Communications Server for Windows NT at Version 6.01 with required
APARs JR13453, JR13599, and JR14098 or IBM SecureWay Communications Server
for Windows 2000 at Version 6.1. (Host systems include MVS, VSE, VM, and
OS/400.)

Currently with Version 6.1, there is an error with configuration verification with
SecureWay Communications Server. To correct this error, use the following
procedure:
1. Go to Start–→Programs–→IBM Communications Server–→Configuration

Verification.
2. Go to File–→Open... and select the controllername.acg file that you want to verify,

where controllername is the name you gave the configuration file.
3. Click on the Checkmark icon and a message similar to the following is

displayed:
Verifying...
PCS7210E The value NN for keyword
/LOCAL_LU[LU_NAME=PSFDCFLU]/DEFAULT_POOL/ is not valid.
Verify ended with errors.

4. Click on the Pencil icon and locate the line that contains LOCAL_LU= and change
the DEFAULT_POOL=NN to 0 (zero), where NN is the number reported in the
message in Step 3.

5. Go to File–→Exit and click Yes when prompted to save the controllername.acg
file.

6. Reverify the controllername.acg file again by clicking on the Checkmark icon.
The following message is displayed:
Verifying...
Verify complete with no errors.

Notes:

1. Preliminary testing has been completed with IBM SecureWay Communications
Server, Version 6.1, and Infoprint Manager for Windows. However, the PSF
Direct Network Configuration Guide that is available on our Web site and
publications CD-ROM was developed and tested using Version 6.01. Minor
differences exist between the two versions, and these differences will be tested
and documented in the future.
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2. If you need to uninstall IBM SecureWay Communications Server, you should
uninstall Personal Communications first. However, if you have installed APAR
JR14481, the uninstall process informs you of this situation.

Creating actual destinations
Before creating an actual destination, IBM recommends that you power on the
actual destination, such as a printer.

Limitations, Restrictions, and Pre-Reqs
This section contains some ″gotchas″ that are not problems with Infoprint Manager
but that could affect the successful use of Infoprint Manager. It also lists pre-reqs.

Passthrough Destinations
Before configuring any Passthrough destinations, you must install the Generic/Text
Only Driver from your Windows CD.

AFP Printer Drivers and Windows Gateways
If a Windows 2000 machine is being used as an Infoprint Manager client and a
Windows NT 4.0 machine is being used as an Infoprint Manager Server, be aware
of the following situation:

A Windows Gateway Printer is created on the Windows NT server machine using
Windows NT AFP drivers. That Windows Gateway Printer is then added to the
Windows 2000 Client machine using the Add Printer wizard. Behind the scenes,
Windows tries to load the Windows NT AFP drivers onto the Windows 2000
machine and the Windows 2000 machine crashes. Do not do this.

Patience When Launching the Operations and Administration
GUI
When you install the Infoprint Manager Server, or install the GUIs from the client
CD, one icon will appear for the Operations GUI and one for the Administration
GUI. When you double click either of these desktop icons, the GUIs may be slow
in starting. Although it may appear that nothing is happening, do not double click
the icon again as this will launch a second instance of the GUI.

Publications CD-ROM
Microsoft Internet Explorer 4.0 is required to view the publications CD. Other
browsers will not properly display the contents of the publications CD. To view
the Infoprint Manager: Reference Information manual, you also need Adobe Acrobat
4.0; however, the PDF on the Web can be viewed with Acrobat 3.0 or 4.0.

JRE Required to Uninstall GUIs
Several places in the Infoprint Manager: Getting Started mention the processes for
uninstalling the JRE or GUIs. If you uninstall the JRE first, the GUIs cannot be
uninstalled since the uninstall process for the GUIs is a Java uninstall process that
requires a version of JRE to run. If you want to uninstall both the JRE and the
GUIs, make sure you uninstall the GUIs first.

Installing the Font CDs
Instructions for installing the AFP Font Collection CD and DBCS font CDs are
contained in the README.NT file on the font CD.

Infoprint Select and the Infoprint Generic Driver
When a user installs Infoprint Select on a client machine from the client CD-ROM,
the Infoprint Generic Driver is also installed on their Windows machine. This
Infoprint Generic Driver can be used when the user creates a select printer on their
client machine. When a job is sent to the select printer that uses this driver, the
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driver sets some job attributes that allows the job to be printed on a PSF actual
destination only. The Infoprint Generic Driver should only be used if the select
printer is configured to point to a PSF destination. An alternate driver for the select
printer should be used if the select printer is configured to point to another type of
printer.

Installing and Uninstalling with Windows 2000
You must have Administrative Privilege to install or uninstall IBM Infoprint
Manager for Windows. If you try to install or uninstall the product without
administrative privilege, the following message is issued:
Setup Installation Error: Setup has detected Uninstallshield is in use,
please close Uninstallshield and restart setup (Error 432).

Ensure that you have Administrative Privilege before attempting to install or
uninstall IBM Infoprint Manager for Windows.

Rebooting at End of Installation
After you have installed IBM Infoprint Manager for Windows, the installation
program asks if you want to reboot your system. The default answer to this
question is Yes because Infoprint Manager will not function properly until the
system is rebooted. When you click OK or press Enter, your system reboots.

If however, you click OK or press Enter more than once, the installation program
may log you off without restarting the system. When you are logged off Windows,
a Shutdown button appears. Press Shutdown and then select Restart the
Computer? from the list box. When prompted, click OK.

Uninstalling a PTF
To remove a PTF from a system and restore Infoprint Manager to an unconfigured
state, follow these steps:
1. Determine if any directories have been moved out from under the Infoprint

Manager install directory since the initial installation. This can be done through
the Infoprint Manager Management Console (Start–→Programs–→IBM Infoprint
Manager–→Management Console). From the Management Console, go
toEdit–→Service Configuration.... Check all paths listed on the displayed panel
to determine if any are not in the base install directory. Make note of any paths
that are not in the base install directory.

2. Uninstall the product. Go to Start–→Programs–→IBM Infoprint
Manager–→Uninstall Infoprint Manager. Follow all instructions as directed.

3. Restart the computer.
4. Delete the install directory. If any directories were moved out from under the

Infoprint Manager install directory (as identified in step 1.), delete those as
well.

5. Install the Infoprint Manager product. Follow the directions as specified.
6. Install any required PTFs to get the product to the desired level.

Release Notes for Version 1.1.0 PTF UR53724 (June 2003)
Please note that PTF UR53724 (APAR IR48693) contains no new functional
enhancements, but does contain over 70 field authorized program analysis reports
(APARs). For a summary of the fixes provided with this PTF, please refer to the
Products Update page of the Infoprint Manager for Windows 1.1 Web site at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipw11ser.
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Release Notes for Version 1.1.0 PTF UR53463 (July 2002)
Please note that PTF UR53463 (APAR IR47615) contains no new functional
enhancements, but does contain 59 field authorized program analysis reports
(APARs). For a summary of the fixes provided with this PTF, please refer to the
Products Update page of the Infoprint Manager for Windows 1.1 Web site at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipw11ser.

Release Notes for Version 1.1.0 PTF UR52773 (January 2002)

Revised Documentation
The following PDFs that are available from our Infoprint Manager for Windows
NT and Windows 2000 site map web page have been revised:
v Infoprint Manager for Windows NT and Windows 2000: Getting Started,

G544-5717-09
v Infoprint Manager for Windows NT and Windows 2000: Procedures, G544-5814-01
v Infoprint Manager: Reference, S544-5475-09

Windows server cannot read ″version″ file in AIX 5.1
namespace

If you are using AIX 5.1 and WinNT SP 6 with Services for UNIX in a multiple
server AIX/Windows environment, you may be unable to start your Windows
server because it fails with Message 5010-845: This server cannot run with a
namespace at Version 999.999 logged in the server log. If this occurs you will
need to ensure that the Windows account under which the IPM for Windows
server runs has write permission to the ″version″ file in the namespace. You can do
this by signing on to the AIX server as root and either:
v Making the Windows account the owner of the version file:

cd $PDNAMESP
chown win-account version

Note: This is the recommended solution.
v Giving universal write permission to the version file.

cd $PDNAMESP
chmod o+w version

Intermittent garbled banner page and ASCII print file on
Infoprint 1130

The banner page that prints on the Infoprint 1130 prints incorrect characters on the
banner page at random times. The next print jobs produce a normal, readable
banner page. Resending the job with the garbled banner page usually results in a
normal banner page.

Release Notes for Version 1.1.0 PTF UR52622 (October 2001)

What’s new in Infoprint Manager

DPF comes to Infoprint Manager
Distributed Print Facility (DPF), a favorite host print submission method in PSF for
OS/2, arrives in Infoprint Manager for Windows NT/2000 with PTF UR52622
(APAR IR44445) (Oct 2001). Sharing your Infoprint Manager server between
multiple host systems and your LAN has never been easier.
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DPF combines simplicity of configuration with the flexibility and power of
Infoprint Manager:
v Minimal configuration on your host system.

In your host PSF, create a TCP/IP printer that sends jobs to your Infoprint
Manager server.

v Host and LAN print management all in the same place.

Since your host print jobs are placed in the Infoprint Manager print spool, you
can see and manage all of your print jobs in the Infoprint Manager GUIs.

v Easy migration from the DPF feature of PSF for OS/2.

Check the Planning Guide for information and instructions about replicating your
existing DPF configuration in Infoprint Manager.

The Planning Guide also provides comparison charts to help you decide which host
print method will work for you (DPF, PSF Direct, or MVS Download), and
worksheets to help you plan your configuration. Once you have a plan, move on
to the Getting Started for instructions on setting up both your Infoprint Manager
server and your host system to use DPF.

If you use DPF in PSF for OS/2, you already know how easy it is to use-- and
what it’s capable of. Virtually all of those capabilities are available in DPF for
Infoprint Manager-- and you’ll be pleased with some of the improvements:
v DPF in Infoprint Manager uses TCP/IP connection instead of SNA, cutting

configuration time dramatically.
v DPF now uses the same Infoprint Manager print spool as all of your other input

methods, not a separate one like PSF for OS/2. You have much more flexibility
in setting up an environment.

In beta tests, customers migrating from PSF/2 had great things to say:

″... the code installed no problem, the DPF receiver was a snap to configure.
Within an hour, I had uninstalled, reinstalled the beta, configured the DPF
receiver and sent print through from the MVS system.″ -- IBM Software
Support Specialist

″A long time IBM customer, Prudential-Bache International (an affiliate of
Prudential Securities Inc) has evolved its use of IBM print solutions as IBM
has introduced new offerings. Prudential-Bache is currently using IBM
Infoprint Manager for Windows NT/2000 with much success. Considering the
IBM product’s wide range of capabilities and options, Infoprint Manager
installs easily. We recently installed a beta version of Infoprint Manager, and
are very pleased with the new Distributed Print Facility (DPF) functionality.
Configuring DPF, changing/adding/removing printers/destinations is
extremely easy and dynamic, as is configuring menu items.″

Infoprint Manager for Windows NT and Windows 2000 PTF UR52622 (APAR
IR44445) was released on 26 October 2001.

Functional enhancements since the last service release
In addition to DPF, the following functional enhancements have been added:
v Support for the Infoprint 4100 continuous forms printer
v Support for the Infoprint 1000 family of printers
v Job submission through Infoprint Manager hot folders
v Support for 2–dimensional barcode printing
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v Support for printing from SAP applications using the sap2afp transform

New and updated documentation
The following documentation has been updated or created in this update:
v Planning Guide (G544–5716)
v Getting Started (G544–5717)
v Infoprint Manager: Procedures (G544–5814)
v Infoprint Manager: Reference (G544–5475)
v Important Information for PSF for OS/2 Users
v Collecting Information from your PSF for OS/2 System
v Setting up to use Infoprint Manager hot folders
v Submitting jobs through Infoprint Manager hot folders
v Installing Infoprint Manager GUI software
v Installing Infoprint Manager Notifications
v Installing Infoprint Select
v Selecting a type of actual destination
v Understanding Printer Drivers, Port Monitors, Windows Gateway Printers, and

Passthrough Printers
v Interrupting and restarting a job that’s already printing
v Moving backward or forward in a job that’s already printing
v Setting up high speed printers for spacing
v Using the Infoprint Manager Line Printer Daemon (LPD)
v Submitting print jobs through the Infoprint Manager LPD
v Managing Security for Infoprint Manager for Windows NT and Windows 2000
v Working with Infoprint Fonts
v Setting up to use MVS Download

Administration and Operations GUIs may cause 100% CPU
Utilization

When using the Administration and Operations GUIs, an interaction between
polling, a large number of retained jobs, and sorting may cause 100% CPU
utilization. Polling retained jobs causes the GUIs to recalculate the time until
discard for retained jobs. This causes the GUI to resort the retained jobs. For a
large number of objects this takes longer than the polling interval, and the GUIs
are continually sorting.

To resolve this problem, please turn off sorting of retained jobs or increase the
polling interval.

Windows server cannot read ″version″ file in AIX 5.1
namespace

Please note that the following condition applies only if your configuration consists
of interoperating Infoprint Manager for Windows NT/2000 servers and Infoprint
Manager for AIX servers. If your configuration only consists of Infoprint AIX
servers, the following will not impact your operations.

Message 5010-845: This server cannot run with a namespace at Version
999.999 is issued when you are running on an Infoprint Manager for Windows
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NT/2000 server that is interoperating with an Infoprint Manager for AIX server
that is running AIX Version 5.1 or above, and you are unable to start the server on
the Windows NT/2000 system.

To fix this situation, complete the following:
1. Ensure that your Service Configuration is properly set by going to the Edit

menu in the MMC and clicking on Service Configuration. The Base namespace
path should contain the path to your exported file system on the Infoprint AIX
server, for example, G:; and the Remote namespace folder should contain the
path on the Infoprint AIX server, for example, amber:/var/pddir/default_cell.

2. Go to a Windows command prompt and change to the drive specified in Base
namespace path on the Service Configuration dialog. At the prompt, enter
type version. If the response is 3.0, your sharing is set up properly.

3. Stop all servers using the namespace. When all servers are stopped, go to a
Windows command prompt and enter erase version.

4. Go to the MMC and select Debug→Create namespace.
5. This recreates the version file, and the Infoprint Manager for Windows

NT/2000 server should start up and interoperate correctly with the Infoprint
AIX server.

Configuring to print DBCS documents in Japanese
To print DBCS documents on the Infoprint 2000 or Infoprint 20 printers, you need
to configure the resources for your actual destination, the job, and the default
document as described in the following sections.

In order to print DBCS documents, you must define a PSF TCP/IP or PSF
Channel-attached printer that supports DBCS. You can use an Infoprint 21, and
Infoprint 70, an Infoprint 2000, or an Infoprint 3130 printer. Whichever printer you
define, remember to set the release timer to 60 seconds or less by clicking the right
mouse button on the printer and then selecting Properties→Tuning tab.

Configuring your Infoprint Manager Actual Destination
Resources
Open the Advanced Infoprint Manager Administrator GUI, highlight the printer
you have defined for printing DBCS documents, and right click on the printer.
Then use the following procedure to configure the printer or actual destination
resources:
1. Select Properties and then click Show more.
2. Select the Appearance tab and select 240 as the Default font resolution.
3. Ensure 240 is listed under values for Font resolution allowed. If 240 is not

listed, highlight 240 under Possible values and click Add.
4. Enter D:\fonts, where D: is the drive where your fonts directory is located, in

the Location of fonts entry field.
5. Enter D:\fonts, where D: is the drive where your fonts directory is located, in

the Location of resources entry field.
6. Click OK.

Configuring your Job and Default Document Resources
Open the Advanced Infoprint Manager Administrator GUI, highlight the logical
device you have defined for printing DBCS documents, right click on the logical
device, and select Job and Document Defaults–→Modify. Then use the following
procedure to configure the logical device resources:
1. Click OK and then click Show more.
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2. Select the Document PSF Resources tab, enter D:\fonts, where D: is the drive
where your fonts directory is located, in the Location of fonts entry field, and
enter D:\fonts, where D: is the drive where your fonts directory is located, in
the Location of resources entry field.

3. Click OK.
4. Select the Document Print Quality tab and highlight 240 in the Font resolution

pull-down and in the Printer resolution requested pull-down.
5. Click OK.

Intermittent garbled banner page and ASCII print file on
Infoprint 1130

The banner page that prints on the Infoprint 1130 prints incorrect characters on the
banner page at random times. The next print jobs produce a normal, readable
banner page. Resending the job with the garbled banner page usually results in a
normal banner page.

DPF Host Receiver fails to start when Jobs directory is
changed

When you are using the Change DPF Host Receiver dialog to change the Jobs
directory, the directory changes are made, but the DPF Host Receiver does not
start. Copy the ALLRAIDS.RA1, ALLRAIDS.RA2, JOBNAME.DA1, and
JOBNAME.DA2 files from the original Jobs directory to the newly created jobs
directory manually, and then start the DPF Host Receiver.

Job prints twice if pdpr command fails on DPF Host Receiver
If the DPF Host Receiver stops because a pdpr command fails, the error is logged
in the Server Log. When the error is corrected and the DPF Host Receiver is
restarted, the job is resubmitted. However, the Host PSF will resend all or part of
the job again, which causes all or part of the job to print twice.

To resolve this, you can delete the job from the print spool if you can identify the
job. Otherwise, recycle the duplicate printed copy.

Reinstalling the Infoprint Manager Administration GUI on a
Windows system

When you reinstall the Infoprint Manager Administration GUI on a Windows
system, any customization, such as menu items or columns in your views, that you
applied is lost. If you want to prevent your customization information from being
lost, do the following before you start to reinstall the GUI:
1. Navigate to install path/ipguiadm where install path is the directory that the GUI

is installed in.
2. In that directory, find the ipgui_pa.cfg file.
3. Copy the ipgui_pa.cfg file to a directory that is outside the install path.
4. Reinstall the GUI, following the directions in the Infoprint Manager for Windows

NT and Windows 2000: Getting Started or the GUI readme file.
5. When the installation is complete, copy the ipgui_pa.cfg file back into the

install path/ipguiadm.
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Release Notes for Version 1.1.0 PTF UR52621 (June 2001)

What’s New with PTF UR52621 (June 2001)
Infoprint Manager for Windows PTF UR52621 (June 2001) was released on 29 June
2001.

Functional Enhancements in Latest Service Release
The following functional enhancements are included in PTF UR52621 (June 2001):
v Made the following enhancements to the Infoprint Manager GUIs:

– In the Advanced and Distributed views, the following default values are set
automatically for PSF actual destinations:
- media-supported
- media-ready
- sides-supported
- plexes-supported
- printer-resolutions-ready
- printer-resolutions-supported

– Added the following tasks:
- Change Job Batch for Actual Destinations
- Change Job Batch for Job and Default Jobs
- Copy/Create PSF Upload SNA Printer wizard
- Copy/Create PSF Upload TCP/IP Printer wizard

v Added FastPath procedures for the operator and compiled the FastPath
procedures with all the procedures for Infoprint Manager for Windows from the
web site into an indexed, PDF file for easier information retrieval and printing,
which is available as a manual entitled Infoprint Manager for Windows: Procedures,
S544-5814-00, at http://www.printers.ibm.com/R5PSC.NSF/Web/infprtm2000.

v Provides the Infoprint pdpr print command as a client on HPUX 11.0 or higher
operating systems to expand the flexibility of Infoprint Manager.

v In addition to Infoprint Manager for Windows: Procedures, S544-5814-00, the
following revised publications are available on the Infoprint Manager for
Windows web site
(http://www.printers.ibm.com/R5PSC.NSF/Web/ipmgrwinnthome) and on the
IBM Printing Systems Digital Library web site
(http://www.printers.ibm.com/R5PSC.NSF/Web/infprtm2000):
– Infoprint Manager for Windows: Getting Started, G544-5717-07.
– Infoprint Manager: Reference, S544-5475-07.

v The Infoprint 70 media sizes supported have changed. Instead of supporting
iso-b4-* and iso-b5-*, Infoprint Manager supports jis-b4-* and jis-b5-*
media sizes for this printer. With regard to this change, please make any changes
necessary to an actual destination’s media-supported, media-ready,
input-trays-medium, and psf-trays-charactersisticsattributes.

Uninstalling the Infoprint Manager GUIs with Windows NT and
Windows 2000

1. Click the Windows Start button and select Settings––>Control Panel.
2. Double-click the Add/Remove Programs icon.
3. Select Infoprint Manager Administration or Infoprint Manager Operations.
4. Click the remove button once, then wait for at least 30 seconds before you do

anything else. If you do not wait for the first panel of the uninstaller to appear,
it may get lost behind other windows. If you don’t see the first panel of the
uninstaller after 30 seconds, press and hold the Alt key, then press the Tab key
to bring the window to the front.
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Release Notes for Version 1.1.0 PTF UR52772 (May 2001)

What’s New with PTF UR52772 (May 2001)
Infoprint Manager for Windows PTF UR52772 (May 2001) was release on 14 May
2001. This PTF provides both English and national language version of the product
including all the functions listed below. It also provides an updated publications
CD that includes documentation in 12 languages.

Note: If you installed PTF UR52620 (March 2001) and do not need other language
versions of the server or GUIs, you do not need to install this PTF.

Functional Enhancements in Latest Service Release
The following functional enhancements are included in both PTFs:
v Support for the Infoprint 70 printer.
v Infoprint DBCS Font Downloader: Utility for downloading PostScript fronts

from a Macintosh system to Infoprint Manager.
v Infoprint Manager GUI online help systems upgraded to use JavaHelp

including new contents, index, and search features.
v Tutorials added to Infoprint Manager GUIs. Look for them in the Help menu

in the Infoprint Manager Administration GUI and the Infoprint Manager
Operations GUI.

v Improved interface for Color Rendering Intent allowing users to control how
out-of-gamut colors are simulated on an IBM Infoprint Color 130 Plus printer.

v Enhancements to the Infoprint Manager Administration GUI and the Infoprint
Manager Operations GUI.

v Enhances PSF other-driver attached actual destinations to allow jobs with
specified document-formats to pass through the device without being
transformed.

v New AFP drivers for Windows 2000 systems.
v Improved support for printing PSF error messages in Japanese.
v Image transforms to transform TIFF, GIF, and JPEG images into AFP.
v New tasks added to the Infoprint Manager GUIs.
v Upgrade to the IBM Cross-Platform Technologies Runtime Environment V.2.0.
v Improved accounting capabilities.

New Publications and Translated Publications available with
PTF UR52772 (May 2001)

One of the CD-ROMs shipped with PTF UR52772 (May 2001) contains revised
publications in English and some of the translated languages used with Infoprint
Manager for Windows. The Infoprint Manager for Windows: Publications (NLV),
SK2T-9299-01, has also been updated with the revised publications in English and
some of the translated languages, and it is orderable online at:
http://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi

Release Notes for Version 1.1.0 PTF UR52620 (March 2001)

What’s New with PTF UR52620 (March 2001)
Infoprint Manager for Windows PTF UR52620 (March 2001) was released on March
26, 2001.

Functional Enhancements in Latest Service Release
The following functional enhancements are included in PTF UR52620 (March 2001):
v Support for the Infoprint 70 printer.
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v Infoprint DBCS Font Downloader: Utility for downloading PostScript fronts
from a Macintosh system to Infoprint Manager.

v Infoprint Manager GUI online help systems upgraded to use JavaHelp
including new contents, index, and search features.

v Tutorials added to Infoprint Manager GUIs. Look for them in the Help menu
in the Infoprint Manager Administration GUI and the Infoprint Manager
Operations GUI.

v Improved interface for Color Rendering Intent allowing users to control how
out-of-gamut colors are simulated on an IBM Infoprint Color 130 Plus printer.

v Enhancements to the Infoprint Manager Administration GUI and the Infoprint
Manager Operations GUI.

v Enhances PSF other-driver attached actual destinations to allow jobs with
specified document-formats to pass through the device without being
transformed.

v New AFP drivers for Windows 2000 systems.
v Improved support for printing PSF error messages in Japanese.
v Image transforms to transform TIFF, GIF, and JPEG images into AFP.
v New tasks added to the Infoprint Manager GUIs.
v Upgrade to the IBM Cross-Platform Technologies Runtime Environment V.2.0.
v Improved accounting capabilities.

Changes not translated
Changes and enhancements made to Infoprint Manager for Windows Version 1
Release 1 are being translated currently and are planned to be available in the next
PTF. This becomes evident when you access an area of either the Infoprint
Manager Administration GUI or the Infoprint Manager Operations GUI that has
changed and it shows up in English while the surrounding information shows up
in the translated language.

Note: The Infoprint Manager GUI help systems changed dramatically in PTF
UR52620 (March 2001). As a result, the help systems for all language
versions of the GUIs will appear in English only. Also, the version of the
GUIs that run on an AIX server will continue to work with Java 1.1.8 as well
as Java 1.3.0, while the GUIs that run on Windows systems will only work
with IBM Cross Platform Technologies Version 2.0.

Revised lpdmap.txt file available with PTF UR52620 (March
2001)

The new sample mapping file, lpdmap.txt, is available with PTF UR52620 (March
2001). The sample lpdmap.txt is located in install_path\bin when service is
applied, but the version of the mapping file that is used by Infoprint Manager for
Windows is located in install_path\var\pd\lpd. Therefore, to use the revised
lpdmap.txt, copy the one from install_path\bin to install_path\var\pd\lpd and
update with any customization changes for your site.

Infoprint Advanced Server changes default to keep failed jobs
Infoprint has changed the default for the hold and save of failed RIP files in the
Advanced Server. The default used to be to delete failed jobs. Now the default is to
keep failed jobs in support of the new function in the Infoprint Manager
Administration GUI menu for Queue—→Keep failed jobs. A Distributed or
Production (Advanced Server) system might want to delete failed jobs to keep the
queues clean and free of bad files. Please check your queues regularly to avoid
experiencing a sudden back-up of failed jobs after upgrading your system to PTF
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UR52620 (March 2001). Queues that existed prior to the PTF are unchanged. Only
new queues created after the PTF is installed are affected by this change.

Use PDF files with LPR Port Monitor and Windows
Passthrough printer

To print PDF files on a Windows Passthrough printer, such as the Infoprint 70 or
Infoprint 21, use the LPR Port Monitor. If you use the IBM TCP/IP Port Monitor,
the PDF files do not print.

Release Notes for Version 1.1.0 PTF UR52402 (December 2000)

Excessive memory use with line2afp transform or ICONV
When you use the line2afp transform either directly or by specifying a
document-format of line-data and you also specify an input exit of asciinpe or an
input exit of apka2e, the line2afp conversion has reduced performance because
this scenario causes excessive memory utilization. The excessive memory
utilization is directly proportional to the size of the file. The combination of the
size of the file and memory available may cause the Windows operating system to
crash before the line2afp conversion is complete. If this happens, you must restart
your Windows operating system.

Errors will also occur if you are running ICONV directly from the command line
or using the ICONV API and specifying codepage 37.

An e-fix is available against PTF UR52402 (December 2000) to correct this problem,
and this problem is also corrected in PTF UR52620, which is available at the end of
March 2001.

All Jobs Already in the PDSERVER Before PTF UR52402
(December 2000) Are Re-Ripped When Sent to the Actual
Destination

After you apply PTF UR52402 (December 2000), all print jobs that you submit will
be RIPped the first time they are submitted, including any jobs you already have
retained on the Infoprint server for re-use. The existing copies of retained jobs are
not compatible with the updated Infoprint Manager server, so they must be
re-RIPped. The first time you print those jobs, you may notice that they take longer
to print due to the time needed to complete the RIP. However, once the new
versions of the jobs are retained, they will print at the speeds you are accustomed
to.

IBM TCP/IP Port Monitor Included on Server CD-ROM
The IBM TCP/IP Port Monitor is included on the Server CD-ROM (Version 1.6 for
Windows NT and Version 2.0 for Windows 2000), and is installed when you apply
PTF UR52402 (December 2000). If you already have the IBM TCP/IP Port Monitor
installed, the Infoprint Manager install checks what level it is. If your port monitor
is an older level for one of the six supported languages, it will be updated. (The
six supported languages are English, French, Italian, German, Spanish, and
Japanese.)

The PTF installation places a file called readmepm.txt under your
systemroot\system32 directory, for example, C:\winnt|system32. The readmepm.txt
is a readme for the IBM TCP/IP Port Monitor.
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Update Notification Client and Notifyd at the same time
Be sure to update the Notification Clients and the Notifyd Server at the same time
to benefit from performance enhancements in PTF UR52402 (December 2000). If
you do not update the Notification Clients when the revised Notifyd Server is
installed, the Notification Clients will not work.

Release Notes for Version 1.1.0 PTF UR52401 (October 2000)

Default Values Changed in ps2afp.cfg, ps2afpd.cfg,
pcl2afp.cfg, pcl2afpd.cfg, and 3160d.cfg files

The new defaults include a page size of 8.5i x 11i, a page offset of 0i x 0i, and a
printer resolution of 300.

If you used the previous default values in these cfg files, you should see an
improvement in your performance when you use the new cfg files. However, if
you use customized cfg files, the new defaults will not affect your performance.

Printing euro characters in ASCII files
If you print an unformatted ASCII file with Infoprint Manager, PSF uses the
proprinter emulation fonts, which use code page T1000850 and C02055D0 by
default. However, code page T1000850 does not include the euro character. To print
the euro character, replace code page T1000850 with T1000858.

Note: The code pages for Infoprint Manager for Windows are in
install_path\fontlib\.

Customizing your Infoprint Manager Administration GUI to
Enable or Disable a Destination

Before you can disable a destination, you may need to customize your Infoprint
Manager Administration GUI as follows:
1. In the Infoprint Manager Administration GUI, go to the Options menu and

select Customize....
2. On the Customize dialog box, select the Logical tab.
3. Under Action, activate the Menu or Toolbar checkbox for Enable and Disable

(Menu places the actions in your Logical menu, and Toolbar places the actions
on your toolbar).

PTF Installation Process creates a sample.zip file
As part of the installation process for PTFs, Infoprint Manager creates a sample.zip
file that contains files you may have changed. The sample.zip file is located in
install_path\var\pdbk\sample.zip. To unzip the sample.zip file, type unzip
sample.zip from the install_path\var\pdbk directory. If you have changed any of
the following files, they were saved in install_path\var\pd\bk\sample.zip.
v install_path\bin\ainu*

v install_path\bin\pdux*

v install_path\bin\mvsdsubm.exe

v install_path\var\pd\mvsd\mvsdmap.txt

v install_path\exits\acif\*

v install_path\exits\mvsd\*

v install_path\exits\psf\*
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v install_path\pcl2afp\pcl2afpd.cfg

v install_path\pcl2afp\pcl2afp.cfg

v install_path\ps2afp\ps2afpd.cfg

v install_path\ps2afp\ps2afp.cfg

v install_path\ps2afp\3160d.cfg

Infoprint Manager Client Installation Instructions
The Infoprint Manager Common Client CD contains the following client software.
Installation instructions are generally found in the readme file within the client
directory.

Table 1. Infoprint Manager client software

Contents of Common Client CD

Directory Contents Instructions

colorripd colorRipd is used to print to InfoColor 70
and Infoprint Color 100 printers by managing
the rips when transferring the ripped data to
the printers.

Select Setup.exe in the colorripd directory.

drivers The AFP print drivers for Windows 9x,
Windows NT, and Windows 2000. The afp
subdirectory contains the Win9x, WinNT,
and Win2000 subdirectories and a readme.

Open the readme file in the afp subdirectory
for instructions about unpacking the drivers.

hpux A client package that installs the Infoprint
Manager commands on an HP-UX system.

Follow the instructions in the readme file in
the hpux directory.

Infoprint Manager
SAP Clients

Client software that allows you to send
PostScript, PCL, OTF, and ABAP output from
SAP systems for Infoprint Manager.

Follow the installation and configuration
instructions in the readme file in the
Infoprint Manager SAP Clients directory.

ipgui Infoprint Manager Administration GUI and
Infoprint Manager Operations GUI. admin
subdirectory contains english, french,
german, italian, japanese, and spanish
subdirectories. oper subdirectory contains
danish, english, finnish, french, german,
italian, japanese, norwegian, schinese,
spanish, swedish, and tchinese
subdirectories.
Note: PDF versions of the Infoprint Manager
GUI operator tutorials are located in the
ipgui/oper/language directories. Navigate to
the appropriate language folder and open the
IPGUITO.pdf file. To view this file, you must
have Adobe Acrobat 4.0.

You use the Infoprint Manager
Administration and Operations GUIs for
most of your day-to-day Infoprint Manager
tasks. For more information on the tasks,
refer to the online Help system in the
Infoprint Manager Administration and
Operations GUIs.

Follow the installation instructions in the
readme file in the ipgui directory.
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Table 1. Infoprint Manager client software (continued)

jre The executable that installs the IBM Cross
Platform Technologies for Windows (CPT)
version 2.0 Runtime Environment for use
with Infoprint Manager Notifications and the
Infoprint Manager Administration and
Operations GUIs.

Follow the installation instructions provided
in the readme files within the Infoprint ipgui
and notification directories.

lfclient The Lightning Fax Client is only used with
Infoprint Manager for AIX, for fax support.

Select Setup.exe in the lfclient directory.

notification Infoprint Manager Notifications client and
readme.

Infoprint Manager Notifications enables a
system to receive notification messages from
Infoprint Manager server systems.

Follow the installation instructions in the
readme file in the notification directory.
Note: There are two setup programs for
Infoprint Manager Notifications. If you are
installing on a Windows system that is
running in Mandarin (Chinese (Taiwan)), use
notifysetup_zh_TW.exe. For Windows
systems running in all other languages, use
notifysetup.exe

select The Infoprint Select client.

The win subdirectory contains an English
readme.htm file and danish, english, finnish,
french, german, italian, japanese,
norwegian, schinese, spanish, swedish, and
tchinese subdirectories.

The OS2 subdirectory contains readmes for
each of twelve languages (the English readme
is available as a flat file and as an htm file)
and danish, english, finnish, french,
german, italian, japanese, norwegian,
schinese, spanish, swedish, and tchinese
subdirectories.

Use the Infoprint Select client client to print
files from familiar workstation applications
across your network.

Follow the installation instructions in the
readme file in the win sub-directory.

sun A client package that installs the Infoprint
Manager commands on a Sun Solaris system.

Follow the instructions in the readme file in
the sun directory.

For the most current information on these products, visit the IBM Printing Systems
web site at http://www.ibm.com/printers. Scroll down to Resources For, select
Infoprint Manager, and then select the appropriate Infoprint Manager product on
the upper right corner.

Trademarks
The following terms are trademarks of International Business Machines
Corporation in the United States, other countries, or both: IBM, Infoprint, AFP, and
AIX.

Windows, Windows NT, and Windows 2000 are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other countries.

Other company, product, and service names may be trademarks or service marks
of others.
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Release Notes for Version 1.1.0 PTF UR52375 (August 2000)

Changing your TCP/IP Settings

Changing the Server Hostname and IP Address
Use this procedure to change the hostname of the system that your Infoprint
Manager server runs on.

Notes:

1. If you have changed the hostname/IP address on the system and already
restarted the system, the Infoprint Manager service will not be able to start and
your Infoprint GUIs will not function properly. Complete the “Changing the
server hostname and IP address” task to correct the problem.

2. If the system that your Infoprint Manager server runs on is part of a domain,
remove it from the domain before you perform this procedure. Complete the
“Changing the server hostname and IP address” task before you add the
system to the domain again.

3. For multi-server environments:

v If you are changing the hostname/IP address on the namespace system, you
must stop all of the non-namespace servers and un-map the network drives
all of the network drives that you have mapped to the namespace system
before you start the procedure below. After you complete the procedure
below, re-map the network drives. Then, use the Management Console (Edit
–> Service Configuration) on each of the non-namespace servers to change
the Base namespace path and Remote namespace folder to the new
hostname and restart the non-namespace servers.

v If you are changing the hostname of a Infoprint Manager non-namespace
server (running on Windows NT or Windows 2000) that shares a namespace
with Infoprint Manager for AIX (with the namespace on an AIX system),
follow the “Changing the hostname of a non-namespace server” on page 19
procedure below.

Changing the server hostname and IP address:

1. If your Infoprint Manager server is running, stop it by selecting File -> Stop
Server in the Management Console.

Note: If you changed the hostname on the system and already restarted the
system, your Infoprint Manager server will already be stopped.

2. If you use Infoprint Manager Security and have changed the member names of
the acl_admin group so they include the hostname, follow these steps:
v In the left pane of the Management Console, open the Security folder and

click the Groups item.
v In the right pane, check to see if any of the member names in the acl_admin

group include the hostname.
v Edit any user IDs in the acl_admin group that contain the old hostname by

replacing the hostname with the wildcard character (*), so you will still be
able to administer Infoprint Manager Security after the hostname is changed.

v Make note of the members that you change so you can replace the wildcard
with the new hostname once it is set.

3. Change the hostname/IP address using Windows interfaces. When the system
asks, choose not to restart the system.
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Note: If you have already changed the hostname/IP address of your system,
you do not have to change them again. Continue with step 4.

4. In the Management Console, select Edit->Changed Hostname.
5. In the Changed Hostname dialog, enter the new hostname. Names are case

sensitive. Make sure the new hostname that you type exactly matches the one
on your Windows system and click OK.

6. When the system asks, restart the system so the changes take effect.
7. Update all of the client systems that communicated with the server using the

old hostname/IP address to use the new one, including:
v Infoprint Select clients
v Infoprint Manager Administration GUI
v Infoprint Manager Operations GUI
v Windows gateway printers
v IPP Gateway clients
v Infoprint Manager Notifications clients

8. Update any Infoprint Manager Security ACLs or groups that reference IDs
using the old hostname. In addition, if you changed any members of the
acl_admin group in step 2, change the wildcard character to the new hostname.

Changing the hostname of a non-namespace server: Follow this procedure only
if you are running both Infoprint Manager for AIX and Infoprint Manager for
Windows as interoperating print servers and need to change the hostname of the
system that Infoprint Manager for Windows is running on.
1. Complete “Changing the server hostname and IP address” on page 18 on the

non-namespace server. At the end of the procedure, the Infoprint Manager for
Windows NT/2000 server should be stopped and can no longer access the
namespace on the AIX machine.

2. On the system that the Infoprint Manager for Windows NT/2000 runs on,
disconnent the network drive that was mapped to the namespace on the AIX
machine.

3. Log on to AIX server machine as root.
4. Follow this path: Smitty–> Infoprint Printing System–> Infoprint Utilities–>

Configure Secondary Servers (NFS)–> Link from Primary Server to
Secondary Server

5. In the dialog that appears:
a. Type the new hostname in the Secondary Server Host Name field.
b. Type the new server IP address in the Secondary Server IP Address field.
c. For Is /ipdata used for job ticketing? answer:

v Yes if you use /ipdata with Infoprint Submit.
v No if you do not.

d. For Retain secondary servers previously defined? answer Yes.
6. On the NT server machine, remap the network drive to the

\\aixserver\var\pddir\default_cell filesystem using the same drive letter that
you used for the network drive that you disconnected in step 2. Map the
drive using the same user id and password that you used during the initial
multiserver environment setup.

7. Log on to the AIX server machine as root.
8. Stop the Infoprint Manager for AIX server.
9. Clear the namespace by issuing the clrfstns /var/pddir/default_cell command.
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10. Create the shared namespace by issuing the crtfstns /var/pddir/default_cell
command.

11. Start the Infoprint Manager for AIX server.
12. Start the Infoprint Manager for Windows NT/2000 non-namespace server.

Changing only the server IP address: If you are only changing the IP address
and you have updated your system name resolution so that the old name resolves
to the new IP address, Infoprint Manager will be reset to use the new IP address
with the old hostname when you restart the system. If any of your Infoprint clients
refer to Infoprint Manager using the IP address, you must update them so they use
the new IP address.

New Publications CD-ROM Available
The publications CD-ROM (SK2T-9288-01) for Infoprint Manager for Windows has
been revised and is orderable.

Release Notes for Version 1.1.0 PTF U469452 (June 2000)

Before Installing this PTF, Save the Customized Values for
your Infoprint Manager Administration and Operations GUIs

If you have customized your Infoprint Manager Administration and Operations
GUIs, you need to save the configuration files before you install the PTF and then
restore the saved configuration files after you have installed the PTF.

For the Infoprint Manager Administration GUI, copy the ipgui_pa.cfg file in
\install_path\ipguiadm\ and save it in a different directory; and for the Infoprint
Manager Operations GUI, copy the ipgui_p.cfg file in \install_path\ipgui\ and
save it in a different directory. After you have installed the PTF, restore the
ipgui_pa.cfg file and the ipgui_p.cfg file in their original directories.

Note: This situation was fixed with the August PTF. Therefore, you do not need to
save your configuration files before you install the PTF.

Release Notes for Version 1.1.0

Changing your TCP/IP Settings
A process for moving and renaming your Infoprint Manager Server will be
documented/automated in the future.

Notes:

1. A procedure for moving and renaming your Infoprint Manager Server has been
automated in PTF UR52375 (August 2000). See “Changing your TCP/IP
Settings” on page 18 for more information.

2. If the IBM Printing Systems Division pre-installed and configured TCP/IP on
your Infoprint Manager for Windows Server, their documentation includes a
procedure for modifying your TCP/IP settings for your individual location.

Limitations with Prolonged Server Activity
Due to known limitations involving prolonged server activity, it is strongly
recommended that the Infoprint Manager Server be stopped and restarted every
seven (7) days to avoid potential problems that could disrupt server processing.
This situation is being addressed and will be resolved in the near future.
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To stop and restart the server:
1. Disable all actual destinations with the Infoprint Administration or Operations

graphical user interface (GUI).
2. Wait for all currently printing jobs to finish.
3. Stop the Infoprint Manager Server through the Management Console.
4. Restart the Infoprint Manager Server through the Management Console.
5. Re-enable all actual destinations through the Administration or Operations

GUI.

Changes needed for Infoprint 21 Configuration File
Go to http://www.printers.ibm.com/R5PSC.NSF/Web/ipntmgr and download the
ibmapmtb.cfg file into your \install_path\npmweb directory, replacing the existing
version of this file. Using the ibmapmtb.cfg file allows your Infoprint 21 and
Infoprint Manager Server to communicate using SNMP.

Note: This is fixed in PTF U469452 (June 2000).
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